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WARRANTY 

 
HARDWARE: Willtek Communications warrants its hardware products to be free 
from defects in workmanship and materials, under normal use and service, for 
one year from the date of purchase from Willtek or its authorised agent. Willtek 
certifies that all instruments are tested and inspected to comply with the 
published specifications originating from the company. 

If a product does not operate as warranted during the warranty period, Willtek 
shall, at its option, repair the defective product or part (except batteries), deliver 
an equivalent product or part to replace the defective item, or refund the 
purchase price paid for the defective product. Transportation of the defective 
product or part to the factory or service centre is to be pre-paid by the customer.  
All products that are replaced will become the property of Willtek. Any replaced 
or repaired product or part has a ninety (90) day warranty or the remainder of the 
initial warranty period, whichever is longer. 

SOFTWARE: Willtek warrants that the software programs licensed from it will 
perform in substantial conformance to the program specifications for a period of 
one year from the date of purchase from Willtek or its authorised agent. Willtek 
warrants the magnetic media containing software against failure during the 
warranty period. Sole obligation hereunder shall be (at Willtek discretion) to 
refund the purchase price paid for any defective software products, or to replace 
any defective media with software which substantially conforms to applicable 
published specifications. Willtek makes no warranty that its software products will 
work in combination with any hardware or applications software products 
provided by third parties, that the operation of the software products will be 
uninterrupted or error free, or that all defects in the software products will be 
corrected. Willtek will make reasonable efforts to provide compatibility, except 
where the non-compatibility is caused by a defect in the third party’s product. 

All information in this manual is given in good faith. However, Willtek 
Communications shall not be liable for any loss or damage whatsoever arising 
from the use of this manual, the product described in it or any errors or 
omissions in either. 

 

 
Willtek Communications 
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Germany 
 
Tel: +49 (0)89 99641 0 
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Willtek 8300 Series Griffin Fast Measurement Receiver Introduction 

INTRODUCTION 

Thank you for choosing Willtek Communications and 
allowing us to support your measurement needs.  

The Griffin range of receivers from Willtek Communications 
are rugged, portable instruments designed for high-
performance and ease of use. The receivers use a PC to 
provide the all of the usual receiver controls as well as a 
range of advanced display formats. These are provided by 
a software package, known as the Griffin Front Panel 
Software, which must be loaded onto a PC before you can 
use the Griffin.  

Thanks again for choosing Willtek Communications 
products. We think that you will find your Griffin a pleasure 
to use and an exciting addition to your portfolio of 
instruments. 

ABOUT THIS MANUAL 
This manual covers using the 8301/8302 Griffin Fast 
Measurement Receiver, the 8381 Griffin UMTS Down 
Converter, the 8382 Griffin Up-Converter, and the Griffin 
Front Panel Software version 15.0. The manual is written 
in a ‘how to’ style familiar to users of Windows 
applications.  

If you need more information about the interface protocol 
between the Griffin and the Front Panel Software, please 
contact Willtek Communications. 

INSTALLING THE GRIFFIN FRONT PANEL SOFTWARE 
Before using the Griffin receiver you must install the Griffin 
Front Panel Software on a suitable PC. Refer to 
Appendix 1 for detailed instructions on installing the 
software. 

CONTACTING WILLTEK 
If you have any problems using the receiver you can 
contact Willtek either directly or via one of our 
representatives and we will do our best to help you. Our 
address and contact details are: 

Willtek Communications GmbH 
Gutenbergstr. 2 – 4 
85737 Ismaning 
Germany 
 
Phone: +49 (0)89 99641 311 
Fax: +49 (0)89 99641 440 
Email: customer.support@willtek.com 
www.willtek.com 
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TROUBLESHOOTING 
Before you call Willtek, be sure to check the 
Troubleshooting Guide appendix to this manual and the 
Willtek web site for a solution to your problem. 

OPERATING ENVIRONMENT 
It is inadvisable to leave the receiver exposed to direct 
strong sunlight or low temperatures for long periods before 
making measurements. The receiver temperature may fall 
outside that given in the specification so causing the 
measurement accuracy to be impaired. 

Only connect the mains supply inside buildings. The mains 
supply is not designed for outdoor usage. 

6  



Willtek 8300 Series Griffin Fast Measurement Receiver Connecting to the Griffin 

CONNECTING TO THE GRIFFIN 

For use with the 8381 Griffin UMTS Down Converter or the 
8382 Griffin Up-Converter, please check the section 
starting on page 12. 

ANTENNA INPUT 
The antenna should be chosen to suit the frequency band 
of the Griffin in use (800 to1000 MHz or 1700 to 
2000 MHz). It can be connected directly to the RF input 
connector or via a length of low-loss cable. The input is a 
conventional 50 Ω N-type.  

A telescopic antenna is supplied with the Griffin. It is 
suitable for general surveying, but, for precision 
measurements, an antenna with a known antenna factor 
should be used. 

RS-232-C 
Connect the Griffin to the COM port on the PC with the Null 
Modem cable supplied. The connectors are the same at 
both ends of the cable so it can be fitted either way around. 

You can use a longer or shorter lead if necessary. It should 
have a 9-way D-type socket at each end and be wired: 
• Pin 2 to Pin 3 
• Pin 3 to Pin 2 
• Pin 5 to Pin 5 
• Shield to Pin 5 at each end. 

POWER CONNECTOR 

DC Power Supply 
You can connect the Griffin to the cigar socket of a motor 
car directly with the lead supplied. The DC input is 
designed for a nominal 12 V supply. Do not connect it to a 
vehicle using a 24 V supply.  

You can use other sources of DC power such as a 
laboratory power supply. Refer to the Specifications 
section for the connections and voltage/current 
requirements. 

Mains Supply 
The Griffin is supplied with a universal mains power supply 
that needs no switch settings to be used on any common 
mains supply. It is has exchangeable adaptors to allow it to 
plug into a variety of mains outlets. 

Choose the right adaptor for your region and slide it onto 
the mains supply then plug the supply into a mains outlet. 
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To protect yourself from an electric shock, NEVER plug an 
adaptor into a mains outlet before it is securely fitted to the 
power supply. 

Only connect the mains supply inside buildings. The mains 
supply is not designed for outdoor usage. 

Internal Batteries 
There is no need to connect an external power supply to 
the Griffin as you can run it off its internal batteries for up 
to four hours. 

AUXILIARY CONNECTOR 
There is no need to connect anything to the Auxiliary 
connector in most applications. This connector has various 
signals to give the Griffin flexibility to meet special 
situations. Refer to the Specifications section for pin out 
and electrical details. 

Remote On/Off 
This line can be used to turn the Griffin on or off remotely. 
When the line is grounded the Griffin will be on. You 
should leave the on/off switch on the Griffin in the Off 
position for the remote control to be able to turn the Griffin 
off. 

This control will work whether the Griffin is powered from 
the external DC input or the internal batteries. If an 
external supply is connected to the battery charge pins 
then any internal batteries fitted will be charged. 

Battery out 
This line provides power from the internal batteries to 
supply external accessories. 

Detector Output 
This is an analogue output with a voltage proportional to 
the logarithm of the input signal level.  

Sampling pulse 
This is an output pulse that is synchronized with the start of 
a measurement in the Griffin. It can be used to synchronize 
external instruments to the Griffin. It is driven from an 
open-collector transistor so to get an output voltage 
change, the output must be connected to a positive voltage 
via a resistor. The resistor value must be chosen to keep 
the maximum current less than 200 mA. 
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PULSE ENCODER CONNECTOR 
There is no need to connect anything to this connector in 
applications where the Griffin is not part of a Willtek survey 
system. 

IF OUTPUT CONNECTORS 
There are two IF Outputs on the Griffin, one for the in-
phase and one for the quadrature components of the IF. 
You can use these to fit external demodulators to the 
Griffin. You should not connect anything to these 
connectors unless they are being used. 

EXTERNAL REFERENCE CONNECTOR 
The External Reference connector can act as an input or 
an output. You can use it to synchronize the synthesizers 
in the Griffin with those in other test equipment. You should 
not connect anything to this connector unless it is being 
used.  

LED INDICATORS 

Front Panel 
The Griffin has a single red LED on the front panel to show 
the state of the power supply. When operating from normal 
supplies it will be on continuously. 

When operating from the internal batteries the LED will 
flash to indicate when the batteries are running low.  
It will start to flash slowly when there is less than about 
15 minutes power remaining in the batteries. The rate of 
flashing increases when the batteries have reached their 
minimum allowed voltage. 

Battery Panel 
The LEDs associated with the two batteries show the 
status of the batteries. 
Off – No battery connected. 
Green – The battery has some charge in it and could be 
used. (It needs not be fully charged). 
Red – The battery is in use. 
Orange – The battery is being charged. 

When both batteries are very fully charged the LEDs might 
flash for a period before settling down. This is normal and 
does not indicate a fault. 
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BATTERIES 
The Griffin is fitted with two batteries each able to run the 
receiver for about two hours. The receiver continuously 
checks the voltages on the batteries and the DC input and 
automatically switches between them. The DC input is 
used if it is connected. If there is no DC input then the 
battery with less charge is used first. Once this battery is 
emptied the Griffin switches to the other battery. 

The batteries as shipped by Willtek will normally be very 
low on charge so you will need to charge them before you 
can use them. 

Since the receiver checks the voltages continuously, you 
can plug or unplug the DC input or remove or fit batteries 
with no interruption to the receiver operation. You must be 
careful, however, when both batteries are running very low 
as the receiver might not be able to switch to a battery 
which is nearly empty. 

If you need to change the batteries when both are very low 
then: 
• First change the battery which is not in use for one 

which has plenty of charge in it.  
• Next change the battery which is in use. 

Fitting and Removing Batteries 
To fit a battery simply push it into an empty socket until the 
retaining clip clicks into place. 

To remove a battery push the retaining clip sideways to 
release it and then allow the spring to push the battery end 
out of its socket. You can then pull the battery completely 
out. 

Charging the Batteries 
The Griffin is fitted with sophisticated charging circuitry 
able to recharge both batteries in about four hours. To 
charge the batteries inside the Griffin, simply supply the 
Griffin with DC power using either the DC power supply or 
the mains supply (see page 7). 

Charging is indicated by a Green LED adjacent to each 
battery. Once the fast charging has finished the batteries 
are trickle-charged to maintain them in good condition. 

For safety reasons, do not charge the batteries in an 
outdoor environment. 

Care of the Batteries 
Each Griffin battery contains five NiMH cells. They are 
protected against over-current and short circuits but it is 
still advisable to treat them with care. 
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All rechargeable batteries have a limited lifetime. The life of 
your Griffin batteries can be enhanced by treating them 
with care. 

Do Not 

• expose the batteries to extremes of heat or cold. 

• continue to use a battery once it is fully discharged. The Griffin 
will give you warnings through the software and by flashing the 
front panel LED when the batteries are running low. It is up to 
you to turn it off or change the supply. 

• Use a battery for anything other than in a Griffin. 

• short-circuit a battery. 

Do 

• run a battery right down and then recharge it. Batteries tend to 
lose their capacity if not used so occasional complete 
discharge and recharge cycles help to maintain them. 

• power the receiver from the mains and leave the batteries in 
and the receiver turned on overnight. This will charge the 
batteries fully and then the long period of trickle charging helps 
to even any differences between the cells in each battery. 

• replace the batteries when the reach the end of their lifetime 
and their capacity falls. 

• store batteries carefully so that they cannot be accidentally 
short-circuited. 

• dispose of old batteries carefully 
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CONNECTING DOWN OR UP CONVERTERS TO THE GRIFFIN 
The capabilities of the 8301 Griffin can be used in other 
bands as well. With the addition of the 8381 Griffin UMTS 
Down Converter, measurements in the frequency band 
from 2000 to 2200 MHz can be taken. And the 8382 Griffin 
Up-Converter allows for measurements in the range from 
300 to 400 MHz. 

       

Connecting the 8381 Griffin UMTS Down Converter 
The 8381 Griffin UMTS Down Converter turns the Willtek 
8301 Griffin Fast Measurement Receiver into a measuring 
device for the UMTS band. The Griffin with the UMTS 
Down Converter is wider than without the converter and 
has four additional connectors (from top to bottom):  

• an N-type antenna connector (UMTS RF In),  

• an N-type RF connector to connect the UMTS Down 
Converter to the Griffin (RF Out),  

• a Lemo-type Auxiliary connector and  

• an SMA reference oscillator input (Ext.Ref.). 

If you want to use the Griffin in the frequency range from 
2000 to 2200 MHz:  

1. Ensure that the RF connector of the Griffin is 
connected to the RF out connector of the converter 
module at the right-hand side. Use cable 382 826. 

2. Use cable 384 896 to connect the Auxiliary connector 
on the Griffin front panel to the Auxiliary connector at 
the module to the right-hand side. 

3. The Ext.Ref. output of the Griffin must be connected to 
the Ext.Ref. input of the converter module with cable 
382 828. 

4. Fix the antenna at the UMTS RF In connector of the 
converter module. 
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5. Follow the instructions on page 23 to set up the Griffin 
Front Panel Software. 

Connecting the 8382 Griffin Up-Converter 
The 8382 Griffin Up-Converter turns the Willtek 8301 
Griffin Fast Measurement Receiver into a measuring 
device for the frequency range from 300 to 500 MHz 
(TETRA, CDMA-450). The Griffin with the Up-Converter is 
wider than without the converter and has four additional 
connectors (from top to bottom):  

• an N-type antenna connector (300 to 500 MHz RF 
In),  

• an N-type RF connector to connect the Up-Converter 
to the Griffin (RF Out),  

• a Lemo-type Auxiliary connector and  

• an SMA reference oscillator input (Ext.Ref.). 

If you want to use the Griffin in the frequency range from 
300 to 500 MHz:  

6. Ensure that the RF connector of the Griffin is 
connected to the RF out connector of the converter 
module at the right-hand side. Use cable 382 826. 

7. Use cable 384 896 to connect the Auxiliary connector 
on the Griffin front panel to the Auxiliary connector at 
the module to the right-hand side. 

8. The Ext.Ref. output of the Griffin must be connected to 
the Ext.Ref. input of the converter module with cable 
382 828. 

9. Fix the antenna at the 300 to 500 MHz RF In connector 
of the converter module. 

10. Follow the instructions on page 23 to set up the Griffin 
Front Panel Software. 

Disconnecting a Converter 
If you want to use the Griffin in the original frequency range 
from 800 to 1000 MHz: 

1. Ensure that the Antenna connector of the Griffin is 
disconnected from the respective connector of the 
converter module at the right-hand side. 

2. Disconnect the Battery out connector on the Griffin 
front panel from the Battery connector at the converter 
module. 

3. Fix the antenna at the antenna connector of the Griffin 
(on the left-hand side). 

4. Follow the instructions on page 24 to set up the Griffin 
Front Panel Software for normal band operation (800 to 
1000 MHz). 
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USING THE GRIFFIN 

This chapter explains how to operate the Griffin with the 
Griffin Front Panel Software. For instructions how to install 
the software on your PC, please refer to Appendix 1. 

Connect a free serial port (COM port) of the PC to the 
Griffin using the RS-232-C cable supplied with the Griffin.  

On your PC, start the Griffin Front Panel Software to 
oeprate the Griffin as explained below. See page 21 to 
ensure proper settings for the communication between the 
Griffin and the PC. 

 

STATUS BAR 
The current status of the Griffin is normally shown on the 
status bar at the bottom of the window. You can turn the 
Status Bar off and on, turn off by ticking or unticking Status 
Bar on the Views menu. 
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Searching or Connected 
When the Front Panel Software is connected to the Griffin 
hardware it will display ‘Looking for Griffin …xxBaud’ and, 
once a reply is received from the Griffin, ‘Griffin 
Connected’. The software searches though all of the 
possible baud rates of the Griffin, starting with the last one 
used. 

If the connection is lost, the status bar will briefly display 
‘Griffin connection failed’. 

Battery Capacity 
The remaining capacity of both batteries is shown running 
from 0 to 100%. This is only an indication of capacity and 
should not be taken as precise. The actual capacity 
remaining will depend on the health of the battery, the 
temperature and the measurements being performed by 
the receiver. 

Although the capacity is displayed as 0 to 100%, the 
receiver only reports 16 separate battery capacities. This 
means that the displayed capacity will change in jumps of 
about 6% rather than continuously. 

Warnings on the Status Bar 
You will see certain warnings appear on the status bar 
from time to time. These warn of situations that do not stop 
the receiver from operating but will result in lost or incorrect 
data. You must correct the problem to make good 
measurements. 

Underrange and Overrange 
Under- and overrange warnings refer to the signal that you 
are trying to measure. They should not be confused with 
an overload warning which might be caused by a signal at 
any frequency at the input to the receiver. 

The Griffin has an instantaneous dynamic range of 80 dB. 
If the signal being measured falls below or above the range 
then it is reported as under or overrange. 

When autoranging is enabled in the Griffin it will try to 
adjust the receiver to suit the dynamic range of the signals 
being measured. Very wide dynamic range signals will still 
cause occasional under/overrange warnings. 

If you have a signal that varies over more than 80 dB you 
could choose to ignore occasional under/overrange 
warnings. No harm will be caused by signals out of range 
signals but obviously they cannot be measured. 

When you have chosen to fix the range in the Griffin you 
must then decide whether to change the range to avoid too 
many under/overrange warnings. 
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You will not get any under/overrange warnings when 
making Histogram, AFD or LCR measurements. 
Histograms ignore any under/over range readings, simply 
reporting the readings that are in range. AFD and LCR 
measurements only look for crossings of the threshold 
level set and treat under/overrange readings as being low 
or high levels. 

Overload 
An overload warning is very serious. It indicates that the 
total power within the RF band of the receiver is so great 
as to overload the receiver. This is often caused by one or 
two very high level signals. It will cause the input circuits of 
the receiver to become non-linear and might produce 
spurious signals or change the level of real signals. 

Note that the receiver need not be tuned to a high-level 
signal. The overload detector is connected to the front of 
the receiver and is sensitive to signals over the whole 
200 or 300 MHz RF bandwidth and even ones just outside 
the band. 

If you have autoranging enabled then the receiver will add 
attenuation at its input to try to reduce the power at the 
input circuits. If the maximum attenuation of 30 dB is not 
sufficient to remove the overload then the environment is 
beyond the capability of the receiver to measure without 
some help. 

If you have chosen to fix the receiver’s range then you will 
have to increase the attenuation until the overload is 
removed. 

If 30 dBs of attenuation is not enough to remove the 
overload then you will need to add an external circuit to 
reduce the total power at the input of the Griffin. If the high-
power signal is the one you are trying to measure or if it is 
very close to it then you will have to add an external 
attenuator. If the high-power signal is a long way from the 
one you wish to measure you might be able to use an RF 
filter to reduce it whilst not affecting the signal you wish to 
measure. You might need to experiment to find the best 
solution in any particular situation.  

The Griffin can be used to indicate the frequencies of high-
level signals that are in-band but any level measurements 
will be inaccurate. 

Synthesizer out of lock 
This message indicates that the synthesizers in the Griffin 
hardware are not working properly. This could be due to a 
poor external reference source or a fault in the hardware of 
the Griffin. 
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If you are using an external reference then try switching to 
the internal reference. If the fault goes away then the 
problem lies with the external reference. Check the 
connections to it and perhaps check that its output meets 
the Griffin’s specifications. 

If you are using the internal reference and the fault persists 
then you must return the Griffin to Willtek for repair. 

Baud Rate too low 
This message means that the Baud Rate you have chosen 
is too low to allow all of the results to be passed to the PC. 
It means that some results are being lost. This might not 
be important if you are simply viewing the results on the 
PC screen but would mean that you are losing results if 
you are logging them to a file. To resolve the problem: 

 
• Check that you are using Binary mode as this is able to 

carry more results. 
• Try to increase the Baud Rate to the maximum that the 

PC is able to support. 
• Reduce the number of results to be sent by increasing 

the Measurement Period or introducing a Pause Time 
after each Measurement. 

This message will not appear when you first start the 
measurements as the Griffin hardware has a buffer of 
64,000 characters and the message will only appear when 
this buffer is full.  

Other problem messages 
There are some other problem messages that can appear 
and which usually mean a problem with the Griffin 
hardware. If you see any other Problem messages please 
refer to Willtek for help. 

Problem Reports 
Some Problems are so serious that the measurements 
cannot be continued. In these cases the Griffin Front Panel 
Software brings up a dialog box to explain the problem and 
stops communicating with the Griffin hardware. 

Lost Connection with the Griffin 
The software polls the Griffin every 10 seconds for its 
status information and if it does not get a reply to the poll 
then it displays this dialog box. Once you click OK, the 
software tries to reconnect to the receiver. Once the 
connection is restored the receiver will be re-programmed 
with your settings and the measurements will resume 
automatically. 

18  



Willtek 8300 Series Griffin Fast Measurement Receiver Using the Griffin 

To resolve the problem first click on OK then check that the 
Griffin still has power and then that the RS-232-C (serial 
link) connectors are still firmly in place. The Status bar will 
show ‘Looking for Griffin’ and ‘Griffin connection failed’ 
messages until the connection is restored. 

This message can be seen on some PCs when switching 
between the Griffin Front Panel Software and other 
applications. The solution is to avoid running other 
applications while using the Griffin.  

Software Problems 
The Griffin Front Panel Software is able to recover from 
many problem situations without any help. Under rare 
conditions it encounters a problem that it cannot overcome. 
It will display a dialog box to describe the problem and then 
the software will stop. Please refer to Willtek for help. 

FEATURES IN BOTH MANUAL AND AUTOMATIC MODES 

Opening and Saving Settings 
You can save and recall all of the settings you have made 
in the Software. In the File menu choose Save Settings or 
Save Settings As to save the current settings. Alternatively 

press the    button on the toolbar. Choose Open 
Settings to restore saved settings. These files have an 
extension of .SMR. 

When you shut-down the software it saves all of the 
settings and restores them when you next start it.  

Changing Mode 
You can change between Manual and Automatic mode in 
any of three ways. 
• Press either the Manual Mode or Auto Mode buttons 

on the toolbar. 
• Click on the Manual Mode item in the Edit menu. 
• Open a setting file in the required mode. 

Display modes 
The Front Panel Software can be run in frequency or 
channel display modes. In frequency mode all frequency 
information is displayed and entered in either MHz or kHz. 
This is the default mode. In channel mode frequency 
information is entered as a channel number. This channel 
number is related to the frequency by the channel 
definitions. Willtek supplies some definitions and you can 
create your own. To change the display mode click on the 
Options item on the Tools menu. Then choose the required 
display mode from the Channel definitions box. For more 
information see Channel Definitions. 
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Improving the Accuracy of Measurements 
The Griffins feature sophisticated algorithms to correct for 
most imperfections in the receiver. To provide optimum 
accuracy over variations in temperature and over the 
extended period between calibrations the receiver contains 
a built-in reference source To get the best precision from 
the receiver you should click on the ‘Self-Correct’ button or 
choose Self-Correct from the Tools menu before making 
measurements.  

It is not necessary to do the self-correction to make 
measurements but the receiver is only guaranteed to be 
within specification after the self-correction measurements 
are made. 

It is best to remove the antenna from the receiver while 
doing the self-correction measurements to avoid a strong 
signal from interfering with them. 

The results of the self-correct measurements are kept until 
the receiver is switched off or reset. Simply changing the 
measurement mode or settings will not lose them. 

Setting Options 
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The Front Panel Software has various options that you can 
use to adjust how it operates. These options are recalled 
the next time you run the Software. To change the options 
choose Options from the Tools menu. This will give you a 
dialog box which has six sections as follows. 

Receiver Connection 
This contains two boxes, one to let you choose the serial 
port (COM1, 2, 3 or 4) and the other to set the baud rate 
from 2400 to 57,600. These settings will be used as soon 
as you click on OK. 

If a Griffin is connected then the baud rate of the Griffin will 
be changed as well. The Griffin will be reset so will lose the 
results of any self-correct measurements made. The Griffin 
will remember the new baud rate even when turned off. 

Reducing the baud rate reduces the amount of data that 
can be sent from the Griffin to the PC. You can very easily 
end up with the receiver producing more data than can be 
sent if you reduce the baud rate from the default of 57600. 
You are strongly recommended to use the highest possible 
baud rate and only to reduce it to overcome problems 
within the PC or the serial connection. 

Log File Delimiter 
When the data are logged to a file, each item is separated 
by a character. This option allows you to choose which 
character Comma, Space or Tab is used. Many programs, 
such as Excel, can use any of these characters as a 
separator so it does not matter which you choose. Some 
programs, however, need a specific separator. You should 
check which is the best option before logging a lot of data. 

Frequency Reference 
The Griffin has an internal precision 10 MHz crystal 
reference, which is used to tune the receiver. You can use 
this reference as an output from the receiver to ensure that 
other equipment is tuned to precisely the same frequency. 
Alternatively you can connect your own 10 MHz reference 
to the receiver which will then use it instead of the internal 
one. The reference needs CMOS/TTL levels and is ac-
coupled within the Griffin. 

Note that when the receiver is corrected in the factory any 
error in this reference is measured and recorded in the 
receiver. This error is used to compensate for the error 
when the receiver is tuned. This means that measuring the 
accuracy of the 10 MHz reference does not measure the 
accuracy of the tuning of the Griffin.  

When the reference input or output is turned on the error 
compensation is disabled to avoid any difference in tuning 
between the Griffin and external equipment. 
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To enable the reference output click on Output Enabled. 
This will disable the External reference input below since 
you cannot have the reference as both an output and an 
input at the same time. 

To use an external reference, first ensure that the Output 
Enabled check box is cleared then select External. 
Connect a low-noise CMOS/TTL level reference to the 
reference input. If the Griffin is not able to use the external 
reference for any reason you will get ‘Synthesizer out of 
Lock’ messages. 

IF Outputs Enabled 
To turn on the two IF outputs check this box. Leaving them 
off saves power when operating from batteries. 

The outputs are the in-phase and quadrature components 
of an image reject mixer at 10.7 MHz. The effective 
bandwidth is far wider than the 15 or 200 kHz IF filters. To 
use these apply to Willtek for technical details of the 
circuitry necessary. 

Binary Mode 
The data can be passed over the RS-232-C link in a form 
that you can read or in a form that only a PC can read. 
Binary mode can only be read by a PC. It has the 
advantage of reducing the amount of data that needs to be 
transferred over the RS-232-C link. You are recommended 
to use binary mode unless you are using a connection 
between the Griffin and the Front Panel Software that 
cannot handle binary data.  

Channel Definitions 
This option allows you to choose how frequency 
information is input and displayed by the Griffin Front 
Panel Software. A wide range of standard channel 
definition files is delivered with Griffin Front Panel 
Software.  

If you choose the Frequency option then all frequency 
information will be in MHz or kHz. If you choose the 
channel option then all frequencies will be represented by 
a channel number.  

To inspect or edit the channel definitions press the Edit 
button. You can also edit the channel definitions by 
choosing the Edit menu followed by Channel Definitions. 

Editing Channel Definitions 
This displays the channel definitions already entered and 
permits you to delete or add entries. Each channel 
definition has the following six parameters. 
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• Definition − This is the name of the channel definition. 
This must be unique. 

• Low Channel Number − This is the channel number of 
the lowest frequency. 

• High Channel Number − This is the channel number of 
the highest frequency. This must be greater than the 
Low Channel Number. 

• Low Frequency − This is the frequency in MHz 
corresponding to the Low Channel Number. It must be 
within the frequency range of the Griffin being used. 

• High Frequency − This is the frequency in MHz 
corresponding to the High Channel Number. It must be 
within the frequency range of the Griffin being used. 
This can be left blank as it will automatically computed 
from the other data. 

• Frequency Step − This is the frequency difference in 
kHz between adjacent channels. 

To navigate between the different channel definitions use 
the  and  buttons. To add a new definition click the 
Add button and fill in the necessary parameters. Click OK 
and the new channel definition will now be available. To 
delete a channel definition, navigate to the required entry 
and press Delete. Note that the IF bandwidth will 
automatically be changed to 15 kHz if the channel 
frequency step is below 100 kHz. 

Using the Griffin with a Converter 
When either the 8381 Griffin UMTS Down Converter or the 
83828 Griffin Up-Converter is being used with the 8301 
Griffin Fast Measurement Receiver, the Front Panel 
Software will apply corrections to the raw readings from the 
Griffin to give the correct power readings. The corrections 
are held in a file which is supplied on a floppy disk with the 
converter. This file has an extension GFC and includes the 
serial number of the converter in its title. This file should be 
copied to a folder on your hard disk, e.g. to the folder 
where the software is installed; depending on the system 
configuration, this could be C:/Program files/Willtek/GFC 
by default.  

To apply the corrections: 

1. Open the Options menu. 

2. In the Griffin Converter section, click the 
appropriate check box (note that the converter 
check boxes are only available if the Griffin being 
used is an 8301 model). 
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3. Select the appropriate correction file in the Griffin 
Converter section. If the required correction file is 
not shown, you can use the browse button to 
navigate to the correct location. 

4. Select Output Enabled in the Frequency Reference 
section of the Options menu (this is automatically 
enabled when selecting a converter). 

 
When the Griffin with the Griffin converter is operating 
properly, the green LED at the module is on. 

Griffin with Converter in Normal Band 
The Griffin with a converter can also be used in the 800 to 
1000 MHz band.  

• For proper connections follow the description on 
page 13. 

• In the Griffin Front Panel Software, uncheck both 
converters in the Griffin Converter section in the 
Options menu described above. 

• Ensure that the Output Enabled check box in the 
Frequency Reference section of the Options menu is 
set if you are using this output connector. 

Using the Toolbar 
The Griffin Front Panel Software toolbar has several 
buttons that act as short-cuts to common actions.  

You can disable the toolbar to get more space on the 
screen for your data by unticking the Toolbar option from 
the View menu. 
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Record, Pause and Stop 

    These buttons allow you to control logging of 
data to a file in Automatic mode. 

Self Correct 

 This starts the self-correction process in the Griffin. 
See Improving the Accuracy of Measurements for more 
details of the process. 

Zero Time 

  Press this button to zero the times shown by the 
Griffin on Graphs or logged to files. These times are taken 
from the PC internal clock and are in seconds. They reset 
to zero whenever you change the receiver settings but not 
when you start logging to a file.  

Reset Peak 

  This is a momentary-action button that resets the peak 
hold display line on graphs. 

Manual Mode 

 This button switches to manual mode. 

Auto Mode 

 This button switches to Auto mode. 

Save 

  This button will save the current configuration. You will 
be prompted for a file name if necessary. 

Edit Parameters 

 This will show the Auto mode parameters form. 

Edit graph Parameters 

 This will show the Graph settings form. 

Zoom Limits 

  The Zoom limits button will be visible in scanning 
mode (but not when doing Histogram measurements). 
Click on it to return the graph to its maximum X and Y 
limits. If the Griffin settings have been changed when you 
used Channel or Frequency zoom functions (see below) 
then the Griffin will be returned to its previous setting.  
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Zoom In 

  This will zoom in on the X-axis. 

Zoom Out 

  This will zoom out on the X-axis. 

Delta Marker 

  Press this button to show two markers, Marker 1 
(green) and Marker 2 (red). Initially they will appear on the 
same frequency or channel so only one will be visible. You 
can move the markers by activating the required marker 
using the  and  toolbar buttons which will now be 
visible, and then clicking on the new position. The 
absolute frequency (or channel) and power of Marker 1 
will be displayed underneath the graph together with the 
relative position and power of Marker 2 with respect to 
Marker 1. 

Marker 1 control 

  If this is selected Marker 1 will be the active marker. 

Marker 2 control 

 If this is selected then Marker 2 will be the active 
marker. 

Peak Search 

 This will move the current marker to the highest peak 
on the visible graph. If the delta marker function is not 
selected the vertical dashed marker will be moved. 

Zoom Graph 

  When this button is selected, zooming does not 
change the settings of the Griffin. It is only a visual zoom. 

Zoom Channels 

  When this button is selected, the Griffin settings are 
changed to scan only the zoomed area, while maintaining 
the frequency spacing between adjacent frequencies. 

Zoom Frequency 

  When this button is selected, the Griffin settings are 
changed to scan only the zoomed area while maintaining 
the total number of frequencies the same. In effect this 
increases the frequency resolution of the zoomed area. 
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Scan 

  This can be used as a shortcut back to scanning mode 
from cycling mode. 

Cycle 

  This can be used as a shortcut to cycling mode. 

Time Mark 

 This is visible when cycling and doing min, mean, max 
or single measurements with the table visible or when 
recording. Press the button to put a mark in the Mark 
column of the table and also in the log file if recording. The 
marks are sequenced numbers.  

MANUAL MODE 

Tuning the Griffin 
There are three ways to tune the frequency of the Griffin, 
either by typing directly into the frequency display, or with 
the up or down spin wheels or in the Parameters dialog 
box. 

To tune the Griffin with the frequency display click next to 
the digit(s) that you wish to change in the display area. 
Delete the digit(s) and then type in the new ones. The 
display will change appearance to show that the frequency 
has not yet been sent to the Griffin. Now you must press 
the Return key to set the new frequency.  

To tune the Griffin with the spin wheels, put the mouse 
over the up or down spin wheel arrow to the right of the 
frequency display then press and hold the left mouse 
button until the frequency you want is reached then release 
the button. The receiver is only tuned to the new frequency 
when you release the mouse button. 

You can change the frequency step size in the Parameters 
dialog box. 

Setting the Receiver Parameters 
To set the receiver parameters click on the Parameters 
button or choose Parameters from the Edit menu. These 
parameters are saved when you save the settings. The 
Parameters dialog box has six sections as follows: 
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Mode 
You can choose one of three measurement modes. 
• Min − The level displayed is the minimum observed 

over the measurement period. 
• Mean − The level displayed is the mean of all levels 

observed over the measurement period. 
• Max − The level displayed is the maximum observed 

over the measurement period. 

Sampling 
This allows you to set the measurement period from  
1 to 650 ms in Mean mode or from 1 to 1300 ms in Min or 
Max modes. 

It also shows you the sampling rate in the chosen 
measurement mode. It will be 100 kHz in Mean mode, 
50 kHz in Min or Max mode.  

IF Bandwidth 
This allows you to set the IF bandwidth of the Griffin to 
either 200 kHz for GSM measurements or 15 kHz for CW 
measurements. 
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Attenuator 
This allows you to set a fixed attenuator rather than allow 
the Griffin to select the attenuator itself. You should choose 
the largest attenuator setting that is suitable for the 
expected range of signals. The setting of Hi Gain uses the 
0dB attenuator with an additional IF amplifier. This is most 
useful when measuring very low level signals with the 
15 kHz IF bandwidth.  

The ranges of signals that can be measured are as follows: 
• 30dB: 0 dBm to –80 dBm 
• 20dB: −10 dBm to –90 dBm 
• 10dB: −20 dBm to –100 dBm 
• 0dB: −30 dBm to –110 dBm 
• Hi Gain: −45 dBm to –125 dBm 

This section of the dialog box also allows you to enable or 
disable the Noise filter. 

Display Units 
You can choose whether to display the data in dBm or in 
dBμV units. If an Antenna factor is being used the data will 
be displayed in dBm/m or dBμV/m. 

Manual Frequency Control 
Sets the amount by which the frequency of the receiver is 
tuned for each press on the frequency setting spin wheel. 

AUTOMATIC MODE 
Automatic mode offers you much more control over how 
the Griffin operates as well as the ability to log the 
measured data to a file for later analysis. 
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Setting the Receiver Parameters 
To set the receiver parameters click on the Parameters 
button  or choose Parameters from the Edit menu. 
These parameters are saved when you save the settings. 
The Parameters dialog box has four sections covering 
various topics as follows. 

Setting the Frequencies 
You can choose between the three frequency modes of 
Fixed, Scanning and Cycling. The Parameters dialog box 
will change to suit the mode you have chosen. 

Fixed 

To set the frequency in fixed frequency mode, type the 
frequency (or channel number) into the Frequency (or 
channel number) entry box. In frequency mode, it can be 
entered with a resolution of 1 kHz. 

In Fixed frequency mode the Griffin remains tuned to one 
frequency (or channel) but pauses in its measurements to 
allow for autoranging. 

Scanning 

In Scanning mode the Griffin scans in equal steps across a 
band of frequencies making the same measurement on 
each frequency. This is most useful for spectrum-analyzer 
type displays showing how the spectrum is occupied 
across a band. 

You must enter three frequencies into the entry boxes Low 
Frequency, High Frequency and Frequency Step if in 
frequency mode, or channel numbers if in channel mode. 

The number of frequencies in the scan is shown below the 
Step box. It is only recalculated when you click outside of 
the entry box. Each scan is limited to a maximum of 
12,000 frequencies. 

Cycling 

In Cycling mode the Griffin’s 150 memories are 
programmed with different frequencies or channels.  
The Griffin goes through its memories making the same 
measurement on each frequency. Unlike Scanning mode, 
the frequencies can be at any spacing and in any order. 
This is most useful for measuring on specific frequencies 
or channels. 

You must enter the list of frequencies in the order they are 
to be measured. 
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To add a new frequency or channel to the list click on the 
frequency or channel that is to follow it in the list. Type the 
new frequency or channel into the entry box then click on 
Add. The new frequency or channel will appear in the list 
before the one you had selected. 

To change a frequency or channel in the list select it by 
clicking on it, change it in the entry box then click on 
Modify. 

To delete a frequency or channel in the list select it by 
clicking on it, then click on Delete. 

To clear all bar one entry from the list click on Clear. 

To fill the list with equally-spaced frequencies click on Fill. 
This will bring up a dialog box allowing you to enter a Low 
frequency, a High frequency and a frequency Step (or 
channel numbers). When you click on OK the frequencies 
or channels will replace those in the frequency list. 

Setting up Cycling Mode from Scanning Mode 
It is often useful to identify frequencies of interest in 
scanning mode and then cycle around them to study them 
in detail. The Front Panel Software makes this process 
easier by allowing you to copy frequencies from a scan to 
the cycle list.  

In scanning mode (apart from histogram measurement 
mode) enable the cycle list information on the right hand 
side of the graph (choose the View menu and then Setup). 
To enter a frequency or channel into the list double click on 
the required position on the graph or single click to position 
the vertical dashed marker correctly and then press the 
space bar. The Frequency or channel selected will then 
appear in the Frequency Cycle list.  

Once you have selected all the frequencies, you can sort 
them by pressing the Sort button. To delete selected 
frequencies or channels use either the Clear All button or 
double click on the entry in the list to be deleted.  

To start cycling on the selected frequencies press the 
Cycle button.  

Choosing the Measurement Mode 
In Automatic mode you can choose between seven 
measurement modes. When you choose the mode the 
Measurement Period entry box will change depending on 
the mode. 

 31 



Using the Griffin Willtek 8300 Series Griffin Fast Measurement Receiver 

Measurement Period on each Frequency 

The minimum Measurement Period on each Frequency is 
generally 1/(Sampling Rate). You can type a new 
Measurement Period into the entry box. The maximum 
period that you can enter is about 65,000 times 
1/(Sampling Rate). To change the Sampling Rate see 
Sampling Settings. 

Single 

In Single mode a single measurement is made. This is the 
fastest mode and allows up to 1000 frequencies to be 
measured per second. 

The Measurement Period will be shown as 0.00 and 
cannot be changed. 

Min 

The level displayed is the minimum observed over the 
measurement period. This mode is particularly useful 
where you need to know that a minimum acceptable level 
is maintained. It can also be use to indicate the range of 
variation of a signal. 

Mean 

The level displayed is the mean of all levels observed over 
the measurement period. This has the effect of filtering the 
signal to reduce sample to sample variations. 

Max 

The level displayed is the maximum observed over the 
measurement period. This is most useful to indicate the 
range of variation of a signal over a period. 

Level Crossing Rate (LCR) 

Level Crossing Rate counts how often a given threshold 
level is crossed during the measurement period. 

When you select the LCR mode two entry boxes will 
appear, one for the level and the other for the hysteresis. 
The hysteresis setting is used to prevent noise on the 
signal from causing many level crossings while the signal 
is near the threshold. The actual levels used by the Griffin 
are the level plus the hysteresis and the level minus the 
hysteresis. 
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If you set a measurement period of one second then the 
result is directly the number of level crossings per second. 
If you set any other period then you must make due 
allowance to normalise the results to the one second rate. 
For example, if you set a measurement period of 200 ms, 
you should multiply the results by 1000/200 or five to get 
the number of times the level is crossed per second. 

Autoranging is disabled during LCR measurements so you 
should select an attenuator suitable for the level you have 
set. 

Histogram 

Autoranging is disabled during Histogram measurements. 

The minimum Measurement Period is 50 ms. 

Average Fade Duration 

Average Fade Duration counts how many samples are 
below a given threshold level during the measurement 
period. 

When you select the AFD mode two entry boxes will 
appear, one for the level and the other for the hysteresis. 
The hysteresis setting is used to prevent noise on the 
signal from causing many decisions while the signal is near 
the threshold. The actual levels used by the Griffin are the 
level plus the hysteresis and the level minus the 
hysteresis. 

You must make due allowance for the sampling rate and 
measurement period to normalise the results. 

Autoranging is disabled during AFD measurements so you 
should select an attenuator suitable for the level you have 
set. 

Griffin Settings 

IF Bandwidth 

This allows you to set the IF bandwidth of the Griffin to 
either 200 kHz for GSM measurements or 15 kHz for 
CW measurements. 

Attenuator 

This allows you to set a fixed attenuator rather than allow 
the Griffin to select the attenuator itself. You should choose 
the largest attenuator setting that is suitable for the 
expected range of signals. The setting of Hi Gain uses the 
0 dB attenuator with an additional IF amplifier. This is most 
useful when measuring very low level signals with the 
15 kHz IF bandwidth. The ranges of signals that can be 
measured are as follows: 
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• 30dB: 0 dBm to –80 dBm 
• 20dB: −10 dBm to –90 dBm 
• 10dB: −20 dBm to –100 dBm 
• 0dB: −30 dBm to –110 dBm 
• Hi Gain: −45 dBm to –125 dBm 

Noise Filter 

This section of the dialog box allows you to enable or 
disable the Noise filter. 

Applying Antenna Factors 
When doing Min, Mean, Max or Single measurements an 
Antenna correction factor can be added to the power 
measurement. This is activated by checking the Apply 
Antenna factor checkbox, which is only visible in these 
modes. To edit the Antenna factors press the Antenna 
Factors button. 

Editing Antenna Factors 

To add an antenna factor, fill in the Frequency entry box 
with the frequency and the Antenna factor entry box with 
the associated Antenna factor and press the Add button. 
The entry will now appear in the list. To modify an entry, 
click on the entry and alter the information as required, 
then press the Modify button. To delete an entry, click on 
the entry and then press the Delete button. 

The Antenna factor used for a particular frequency will be 
interpolated if that frequency is between two entered 
antenna factor frequencies. If it is not between two entered 
antenna factor frequencies it will be set to the antenna 
factor associated with the nearest antenna factor 
frequency entered. 

Sampling and Noise Filter Settings 
To change the sampling noise filter settings click on the 
Advanced button to bring up the Advanced dialog box. This 
allows you to change three parameters – Sampling Rate, 
Pause Time after each measurement and the Noise filter 
bandwidth. 

Sampling Rate 

The Sampling Rate sets the number of samples per 
second that the Griffin uses to make the measurement that 
you have selected. 
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In general it is better to leave this at its default setting 
which will be its fastest. The main reason to use slower 
sampling rates is when you need to sample over an 
extended period. The Griffin can take up to a maximum of 
65,535 samples to make a single measurement. At a 
sampling rate of 100 kHz this takes 655 ms. If you need to 
sample for longer than 650 ms you must reduce the 
sampling rate. 

The maximum sampling rate is 100 kHz for mean 
measurements and 50 kHz for all other measurement 
modes. 

Pause Time after each Measurement 

Normally the Griffin will start a new measurement as soon 
as it can after finishing the previous measurement. The 
minimum time between measurements is just under 1 ms, 
which is the time the receiver takes to tune to the new 
frequency. You can make the receiver pause between 
measurements by entering the pause time into this entry 
box. This allows you to create measurement patterns such 
as taking the mean over 10 ms every 100 ms. 

The minimum time allowed will depend on the IF 
bandwidth and the Noise filter bandwidth chosen. The 
maximum time depends on the Sampling Rate. If you need 
to enter a longer time than is allowed then you must 
reduce the sampling rate. 

Noise filter 

The Noise filter in the Griffin is similar to the Video filter in 
a spectrum analyzer. It filters the signal after the detector 
to reduce noise before it is sampled. 

You can choose a noise filter bandwidth between 200 Hz 
and 12.5 kHz. 

The disadvantage of a narrow noise filter is that it reduces 
the number of RF channels that you can measure in a 
second as it takes longer for the filter to settle. If you have 
problems with noisy signals try different noise filter settings 
and consider using mean measurements over different 
periods of time.  

Sampling 

This allows you to set the measurement period from  
1 to 650 ms in Mean mode or from 1 to 1300 ms in Min or 
Max modes. 

It also shows you the sampling rate in the chosen 
measurement mode. It will be 100 kHz in Mean mode, 
50 kHz in Min or Max mode.  
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Display Units 
You can choose whether to display the results in dBm or in 
dBμV units. This setting will select the units for all of the 
ways of viewing the results. If an Antenna factor is being 
used the data will be displayed in dBm/m or dBμV/m. 

Measurement Statistics 

Frequencies per second 
This shows the number of frequencies that the Griffin 
measures on per second. The maximum rate of 
1000 frequencies per second is only feasible with the 
200 kHz IF filter and taking a single sample on each 
frequency. Many settings will reduce the maximum 
available rate. For example, using the 15 kHz IF filter, 
using the Noise filter or doing a Mean measurement. 

Sometimes the values here can be confusing, the thing to 
remember is that the Griffin needs some time to change 
frequency and then for its filters to settle. (It is the settling 
time that is affected by your choice of IF filter and Noise 
filter.) So, if you select a Measurement Period on each 
frequency of 10 ms, the actual time needed on each 
frequency is 11 ms and the number of Frequencies per 
second is shown correctly as 90.91. Setting a 
Measurement Period on each frequency of 9 ms, results in 
a time of 10 ms on each frequency and 100 frequencies 
per second. 

Time to do one cycle or scan 
This is the time taken to complete each Cycle or Scan. 
For example, if you have set the Griffin to scan 
1000 frequencies per second and there are 
500 frequencies in the scan then the Time to do one  
cycle or scan will be 500 ms. 

Complete cycles/scans per second 
This is the reciprocal of the Time to do one cycle or scan, 
so in the example above it will read 2. 

Samples per frequency 
This is the number of samples taken on a frequency to 
make a single measurement. (It is not the total number of 
samples on that frequency per second.) Mathematically it 
is the Measurement Period on each frequency multiplied 
by the Sampling Rate. You can change this by changing 
the Measurement Period on each frequency or the 
Sampling Rate. 
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Pause time after each measurement 
This is the time that the Griffin takes to move from one 
frequency to another and for its filters to settle ready to 
start the next measurement. This will depend on the 
IF filter and Noise filter that you have chosen. 

You can increase the time beyond its minimum with the 
Pause time entry brought up after pressing the Advanced 
button. 

Samples per second 
This is the average sampling rate achieved. It will never 
reach the 100 kHz (Mean measurements) or 50 kHz (all 
other measurements) maximum sampling rates as some 
time is lost while the Griffin is re-tuning.  

For example, if you select a Mean measurement over 1ms, 
200 kHz IF filter and Noise filter disabled, the Griffin will 
spend 1 ms measuring on each frequency and 1 ms 
changing from frequency to frequency. Thus the receiver is 
only sampling for half the time and the Samples per 
second will read 50,000 even though the sampling rate is 
100 kHz. 

VIEWING THE RESULTS 
Automatic mode offers you four ways of viewing the 
measurements by the receiver. Any combination of views 
can be used at the same time and various parameters can 
be changed to suit the measurements you are making. 

You can Close, Minimise, Restore or Maximise a View with 
the familiar three buttons at the top right of the View’s 
window. (The exceptions are the Form and Bar Graphs 
Views which can only be closed.) 

Form View 
The Form View in Automatic mode shows the results of 
different measurements. When doing AFD or LCR 
measurements it will show counts rather than signal 
strengths. It is not suitable for use with Histograms. 

When Cycling or Scanning it will attempt to show the result 
for each frequency in turn. When the receiver is covering 
more than about 10 frequencies per second it is not 
possible to see the individual results and the Form View is 
of limited value. 

The scaling for the bar on the form is always sufficient to 
cover the full range of the receiver (−130 to +10 dBm, 
−30 to +110 dBμV or 0 to 65,535 counts). 

The size of the Form View is fixed and it cannot be 
changed. 
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Graph View 
The Graph View shows line graphs of your results and 
automatically adapts to suit different measurements. There 
are many Graph Settings that you can use to customize 
the Graph change. 

To change the settings choose Graph Settings from the 
Edit menu to bring up a form with five sections as detailed 
below. 

To change the size of the Graph View hold your mouse 
over the edge of the Window and drag it to the new size. 

Ranges 
To Change the scaling of the Y-axis you can change the 
Maximum and Minimum values for the axis. The units for 
the axis will change to suit the units that you have chosen 
for the measurements.  

Memory Cycling Min/Mean/Max/LCR 
This section of the Form will only be enabled if you have 
selected Memory Cycling otherwise it will be greyed out. 

Display frequencies 

The Graph is able to display the results from up to ten 
frequencies at one time, each in a different colour. You can 
choose which frequencies to display by checking or  
unchecking the box next to the frequency. All of the 
frequencies programmed into the receiver are listed on the 
form. 

The frequencies selected to be displayed on the Graph will 
also be shown as columns on the Table View and as Bars 
on the Bar Chart View. 

To change the number of intervals shown on the X-axis 
type the new number into the entry box.  

Histograms 
This section of the Form will only be enabled if you have 
selected Histograms otherwise it will be greyed out. You 
can choose whether to display all Histograms or only those 
from a single frequency.  

Choose Show All Histograms to see the Histograms from 
each frequency one after the other. The title of the Graph 
View will change to show the frequency of the Histogram 
being displayed. You can use the Peak Hold to compare 
the Histograms as it will show the peak of all of the 
Histograms.  
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Choose Single Frequency and then select the frequency to 
see only the Histograms from one frequency. Note that the 
Griffin continues to measure the Histograms on all 
frequencies and, if you are logging the results, they will all 
be logged to file. 

Scanning Min/Mean/Max/LCR 
This section of the Form will only be enabled if you have 
selected Scanning otherwise it will be greyed out. You can 
choose between three formats for displaying the results of 
the scanning. 

Frequency/Signal Strength – Line Graph 

Choose this format to see a line graph showing the 
measured Signal Strength on the Y-axis against Frequency 
on the X-axis. The measured value need not be a Signal 
strength, it could be a Minimum, Maximum, Average Fade 
Duration or Level Crossing Rate. 

Frequency/Signal Strength – Bar Chart 

Choose this format to see a bar chart showing the 
measured Signal Strength as the height of a bar, with one 
bar for each frequency. The measured value need not be a 
Signal strength, it could be a Minimum, Maximum, Average 
Fade Duration or Level Crossing Rate. 

Time/Signal Strength 

Choose this format to see a line graph showing the 
measured Signal Strength for a single frequency on the  
Y-axis against Time on the X-axis. The measured value 
need not be a Signal strength, it could be a Minimum, 
Maximum, Average Fade Duration or Level Crossing Rate. 

To change the number of intervals shown on the X-axis 
type the new number into the entry box. 

Peak Hold 
You can turn the Peak Hold function on or off by ticking or 
unticking this check box. 

Zooming Functions 
You can zoom into the graph data when in scanning mode 
(apart from during Histogram measurements). Zooming 
functionality is determined by which Zooming mode button 
is selected. These buttons are located on the right of the 
toolbar. See Zoom Graph, Zoom Channels and Zoom 
Frequency for specifics on the different zooming modes. 
You can zoom by clicking and dragging a zoom rectangle 
on the graph. This action can be cancelled by using the 
escape button. You can also use the Zoom In and Zoom 
Out buttons. 
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Markers 
In scanning mode (apart from Histogram measurements) 
there are two marker modes available. The default mode is 
the normal marker mode. In this mode there is one marker 
indicated by a vertical and a horizontal dashed line. The 
marker power and frequency (or channel number) are 
displayed below the bottom left of the graph. The other 
marker mode is the Delta marker mode. See Delta Marker 
for more information on this mode. 

Table View 
The Table View shows up to ten columns of your results as 
numbers. It is only available in Fixed and Cycling modes. 

The left-most column shows the time on the PC clock 
when the measurement was made. The next column 
shows the time from the start of the measurements or 
since you pressed ‘Zero time’. The next column shows if 
any of the measurements were overloaded. The remaining 
columns excluding the right-hand column show the 
measured results in the units you have selected. The final 
column is headed "Mark" and will show a number if the 
Time Mark button has been pressed during a 
measurement. See Time Mark for more details. To change 
the units refer to Display Units in Setting the Receiver 
Parameters. 

To change the number of columns and which frequencies 
they list choose Graph Settings from the Edit menu and 
tick or untick the Display frequencies. 

To change the size of the Table View, hold your mouse 
over the edge of the Window and drag it to the new size. 

Bar Graphs View 
The Bar Graphs View shows the measured results as bars. 
It is only available in Fixed and Cycling modes. In 
Scanning Mode a similar result can be obtained by using 
the Bar Graph option on a Graph View. 

To change which frequencies are displayed choose Graph 
Settings from the Edit menu and tick or untick the Display 
frequencies. 

To change the units refer to Display Units in Setting the 
Receiver Parameters. 

To change the Y-axis of the Bar Graph View, select the 
Edit menu and Bar settings. Enter the required maximum 
and minimum values and press OK. 

Making More Space Available on the Screen 
You can turn off the Status Bar and the Toolbar to make 
more space available for the Views. On the Views menu 
turn off the tick against Status Bar and Toolbar. 
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LOGGING THE DATA 
When in Automatic Mode you can log the data to a file by 
clicking on the Record button or by choosing Start 
Recording from the Tools menu. 

You will be asked if you wish to Perform Self-Correct on 
the Griffin before recording. You can answer yes to do the 
self-correction measurements, No to skip them and start 
recording or Cancel to not start recording at all. 

If it is estimated that there is less than 10 hrs recording 
time left, you will be told approximately how long the 
recording can continue before filling the available space on 
your hard disk. It is a very rough estimate and should only 
be used as a check.  

You can Pause and then restart the logging of data by 
clicking on the Pause button or choosing Pause Recording 
from the Tools menu. The Griffin will continue to make 
measurements while logging is paused. 

When you have finished logging click on the Stop button or 
choose Stop Recording from the Tools menu. You will then 
be shown the usual file save dialog box to allow you to 
select the folder and file name. 

HELP SYSTEM 

Diagnostics 
The Diagnostics item on the Help menu brings up a box 
with two entries – Power-Up Status and Report Status.  
You will probably find that the contents are not particularly 
easy to interpret yourself as they are there to help Willtek 
to help you if there is a problem with the receiver. If you 
contact Willtek to ask for support you might be asked to 
report the contents of the Diagnostics window. 

Power-Up Status 

This should be a line of 12 zeros. It indicates any faults 
found with the Griffin during the power-up self-test process. 
If any of the zeros is a 1 then a fault was found. To find out 
what was faulty press the details button or refer to the item 
‘Power Up Self Test’ in the appendix ‘Griffin Commands’.  
If you have a fault try the following: 
• Check the power supply to the receiver. 
• Check the ambient temperature (−10 to +40 for normal 

operation). 
• Turn off and on a few times to see if the fault is 

continuous or intermittent.  

If the fault persists then you must return the receiver to 
Willtek for repair.  
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The receiver will try to make measurements even if a fault 
is found but you should be very careful as the results might 
be wrong. 

Report Status 

The Report Status line contains eight groups of two 
hexadecimal digits. This is updated about every 
10 seconds by the Front Panel Software polling the 
receiver for its status. To find out what the status means 
press the Details button or refer to the item ‘Status 
Reports’ in the appendix ‘Griffin Commands’. 

About Griffin 
Click on this menu item to see the version of the Front 
Panel Software that you are running. 

Manual and Automatic Modes 
The Griffin can be used in two modes called Manual and 
Automatic. 

In Manual mode the Griffin emulates a conventional 
receiver, reporting a single RF level on a bar-chart and 
providing basic controls. 

In Automatic mode the Griffin uses its advanced features 
to provide scans and measurements beyond the 
capabilities of conventional receivers. The results can be 
viewed in different ways and stored in files for future 
processing. 
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SPECIFICATIONS 

NORMAL CONDITIONS 
Unless otherwise qualified, these specifications apply at 
25°C, and using the 200 kHz IF filter and 0 dB attenuator 
setting. 

SPECIFICATIONS OF THE WILLTEK 8300 GRIFFIN SERIES 

Frequency 
Input Frequency Range 800 to1000 MHz (Willtek 8301) 

1700 to 2000 MHz (Willtek 8302) 

Tuning Increment 1 kHz 

Tuning Speed 1 ms 

Input 
Maximum Input measurable 0 dBm (30 dB attenuator) 

−10 dBm (20 dB attenuator) 

−20 dBm (10 dB attenuator) 

−30 dBm no attenuator 

Input 3rd Order Intercept Point > 20 dBm (30 dB attenuator)  
±2 MHz of tuned frequency 

> 30 dBm (30 dB attenuator) within 
RF bandwidth 

Overload Detector Broadband input level measurement 
detects high-level off-channel signals 
that might cause overload.  

RF Input Impedance 50 Ω nominal 

Connector N-type 

Input VSWR < 1.6:1 typical 

Maximum Safe RF Input +20 dBm 

Input Clipping Level 5.6 V peak-to-peak 

DC Blocking ±50 V maximum 

Input Protection To meet ETS 300 339 

Attenuation 0, 10, 20, 30 dB Switched 
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Dynamic Range 
Instantaneous Dynamic Range 80 dB (corrected) 

Noise Floor −112 dBm typical 

In-band Blocking 

600 MHz to 1200 MHz or  

1400 MHz to 2300 MHz 

Less than 1 dB error in measured 
level of a signal at −104 dBm for 
inputs at: 

600 kHz to 800 kHz, −38 dBm 

800 kHz to 1.8 MHz −33 dBm 

> 1.8 MHz −23 dBm 

Out-of-band Blocking < 600 MHz or 
1200 MHz to 1400 MHz or 
> 2300 MHz 

Less than 2 dB error in measured 
level of a signal at −104 dBm for 
inputs at 0 dBm 

De-sensitisation (10 dB attenuator) > −20 dBm at ±1 MHz of tuned 
frequency 

A signal at this level will cause 
< 0.3 dB error in measured signal 
level of a signal at −60 dBm 

Level Measurements 
Gain Change over Full Temperature 
Range (analogue path, uncorrected) 

< 3 dB 

Gain Change over Power Supply 
Voltage Range (analogue path, 
uncorrected) 

< 1 dB 

Gain Drift per year (analogue path, 
uncorrected) 

< 1 dB 

Warm-up Time < 5 minutes to quoted measurement 
accuracy 

Amplitude Measurement Error after 
correction 

±1 dB 

Response Time 

(Noise filter out) 

< 1 ms to produce output within 
0.5 dB of steady-state value following 
channel change command 

Analogue RSSI Bandwidth > 12 kHz 

Post-Detector Filtering (Noise filter) Switched bandwidths of: 

200, 400, 800, 1600, 3125, 6250, 
12500 and 'out' 

Sampling Rate (maximum) 100 k samples per second 

Sampling Interval (time-based 
sampling) 

10 μs to 13.1 ms in 200 ns steps 

Distance Measurement Input Up to 500 pulses per metre at 35 m/s 

44  



Willtek 8300 Series Griffin Fast Measurement Receiver Specifications 

Sampling Interval (distance-based 
sampling) 

Minimum one pulse, maximum 65,535 
pulses (0.05 to 300 metres at 
200 pulses/metre) 

Sequence Modes Fixed, Cycling, Scanning 

Measurement Modes Single, Histogram, Min/Mean/Max, 
Level Crossing Rate / Average Fade 
Duration 

Histogram Measurement Rate 50 histograms per second maximum 

Number of samples per measurement Up to 65,535 samples per 
measurement 

Number of measurements per 
frequency 

Up to 255 measurements on each 
frequency 

Number of frequency memories 150 

Distance Input 
Interface DC supply output to the distance 

encoder and logic-level pulses input 

Output Pulses output for use by navigation 
receiver, open collector, 20 V, 50 mA 
maxima 

Reference Characteristics 
Reference Frequency 10.0 MHz 

External Reference Input AC-coupled CMOS/TTL logic levels 

±50 V DC maximum 

External Reference Output AC-coupled CMOS/TTL logic levels 

Reference Connector SMA 

Reference Warm-up Time < 5 minutes to quoted frequency 
accuracy 

Tuning Accuracy Within 2 kHz 

Ageing Rate < 1 kHz/year 

Reference Adjustment Range Unlimited under firmware control; 
has no effect on the reference output 

IF Filtering 
200 kHz Bandpass Response −1dB > 100 kHz 

−3 dB < 220 kHz 

−60 dB < 400 kHz 

Passband ripple < ±1.5 dB 
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15 kHz Bandpass Response −1 dB > 12 kHz 

−3 dB < 18.5 kHz 

−60 dB < 50 kHz 

Passband ripple < ±1.5 dB 

Unfiltered IF I&Q Output 
IF Frequency 10.7 MHz 

Format I&Q signals 

Needs an image reject mixer with 
20 dB rejection to achieve specified 
performance 

Maximum Level −18 dBm typical 

Minimum Level −98 dBm typical (assuming 80 dB of 
dynamic range) 

Amplitude Imbalance Within 6 dB 

VSWR < 1.6:1 

Bandwidth 1.6 MHz 

Gain Variation < 5 dB All effects 

Connector SMA 

Harmonics < 40 dBc 

Spurious Responses 
Adjacent Channel Rejection (200 kHz) > 70 dB typical (unmodulated carrier, 

±400 kHz) 

Adjacent Channel Rejection (15 kHz) > 60 dB typical (unmodulated carrier, 
±200 kHz) 

Image Rejection > 70 dB 

IF Rejection > 70 dB 

Harmonically Related Spurious 
Response Rejection 

> 50 dB 

Spurious Signal Level  
(non-harmonically-related) 

< −90 dBm 

In-band Intermodulation Products at 
Unfiltered IF Output 

< 60 dBc (two tones at 20% of 
channel bandwidth) 

Conducted Spurious Emissions < 2 nW (< 1 GHz) 

< 250 nW (> 1 GHz) 

Radiated Spurious Emissions < 2 nWerp (< 1 GHz) 

< 250 nWerp (> 1 GHz) 
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Control 
RS-232-C Baud rates of 57600, 28800, 14400, 

38400, 19200, 9600, 4800, 2400 

RS-232-C Handshaking Xon/Xoff protocol 

Processing 
Processors Dual 32-bit Motorola 68332 

processors 

Clock Speed 25 MHz 

ROM 640 kB 

RAM 432 kB 

Battery Power 
Supply Batteries or external DC input 

Batteries Two 6 V 4 Ah NiMh batteries each of 
five cells. One can be changed whilst 
the other is in use. 

Battery Size 140 x 55 x 20.5 mm, weight 300 g 

Battery Voltage +6 V; +1.5 V, −0.5 V 

Power Consumption < 12 W at 7 V input 

Battery Life Time 2 hours per battery 

Can change batteries to achieve 
unlimited operation 

Battery Charging Internal charger giving 4 hour charge 
time followed by continuous trickle 
charge 

Powered from an external DC source 
separate to receiver power 

Battery Charge Power 12 V nominal at 2 A 

Battery Charge Time 4 hours maximum inside the receiver 

Battery Indicators One for each battery 

Red means in use 

Green means available 

Amber means on-charge 

Off means not in use 

External Power Input 
External DC Input 9.5 to 18 V 

External DC Connector 7-pin Lemo size 1B 
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Current 2.5 A maximum with batteries inserted 
and on charge from a 12 V supply 

1.5 A maximum without batteries 
inserted 

Environmental The batteries contain no Pb, Cd or Hg 
materials 

Signals 
Protection All signal lines are protected against 

static discharges and EMC 

Distance Pulses Input Logic level pulses from a wheel 
encoder 

Auxiliary Pulses Input Logic level pulses 

Can be used to trigger the receiver or 
as alternative distance pulses 

Remote On/Off Ground to turn the receiver on 

Sampling Pulse Out Logic level pulse 

Indicates when the receiver samples 
the detector output 

Distance Pulses Output Logic level pulses 

Connected to the wheel encoder 
input. Intended for a navigation 
receiver 

Detector Output Approx. 0.65 to 2.5 V from an op-amp 
output at 25 mV/dB 

Mechanics 
Receiver Size 240 x 170 x 92 mm 

Appearance Blue Texel textured paint 

Receiver Weight 3.32 kg estimate, including batteries 

Indicators One LED to show when on 

One LED for each battery to show 
state 

Environmental 
Operating Temperature Range −10 to +45°C 

Temperature Range for Full Accuracy +5 to +35°C 

EMC Approval (fully assembled into 
case, using the cables provided by 
Willtek for use with the Griffin) 

ETS 300 339 
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CONNECTOR DETAILS 

RF Input 
Standard 50 Ω N-type. 

I&Q Outputs 
Standard 50 Ω SMA (one for the I output and one for the Q output). 

RS-232-C 
Standard 9-way D-type with pins. 

Tx Data, Rx Data, as RS-232-C levels. (RTS, CTS connected but not used). 

 
Computer Griffin 

Function 25-way connector 9-way connector 9-way connector
Ground 7 5 5 
Tx Data from PC 2 3 2 
Rx Data to PC 3 2 3 
CTS to PC 5 8 7 
RTS from PC 4 7 8 

Auxiliary Connector Functions 
Seven-way Lemo plug with a green strain relief. The connector is Willtek part 
number 591360, Lemo part number FGA1B307CLCD72Z (two keyways, 30°). 
The green strain relief boot is Willtek part number 591330, Lemo part number 
GMA1B065DV). 

 
Pin Function Specification 

1 Ground  
2 Remote on/off. Ground to turn 

receiver on.  
Open circuit 3 V. 
Current to ground 0.5 mA. 

3 Wheel encoder pulse input or 
output.  

TTL level pulses. Must have a 
short rise-time. 
Directly connected to pin 3 of 
the Pulse Encoder connector. 

4 Auxiliary pulses input. TTL level pulses. Must have a 
short rise-time. 
Directly connected to pin 4 of 
the Pulse Encoder connector. 

5 Raw battery voltage out. 
Switched to the battery or DC 
supply in use. 

+5.5 V minimum. 
300 mA maximum available. 

6 Log amp output.  Approx. 0.65 V for minimum 
RF input. 
Scaling approx. 25 mV per dB 
over 80 dB range. 
Minimum load 1 kΩ. 
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Pin Function Specification 
7 Sampling pulse output. Open collector output, max 

sink current 200 mA. 
Maximum voltage +30 V. 

Power Input Connector 
Seven-way Lemo plug with a red strain relief. The connector is Willtek part 
number 591358, Lemo part number FGG1B307CLCD42Z (one keyway). The red 
strain relief boot is Willtek part number 591328, Lemo part number 
GMA1B035DR). 

 
Pin Function Specification 

1 Ground  
2 Remote on/off. Ground to turn 

receiver on.  
Open circuit 3 V. 
Current to ground 0.5 mA. 

3 Not used  
4 Not used  
5 +12 V input. This will power 

the receiver and any items 
connected to it. 
Will not charge the batteries. 

See above for specification. 

6 Batteries charge supply 12 V nominal, 1.5 A to charge 
the batteries. 

7 Not used  

Pulse Encoder Connector 
Seven-pin Lemo connector colour-coded blue. 

Seven-way Lemo plug with a blue strain relief. The connector is Willtek part 
number 591359, Lemo part number FGB1B307CLCD72Z (two keyways, 45°). 
The green strain relief boot is Willtek part number 591330, Lemo part number 
GMA1B065DA). 

 
Pin Function Specification 

1 Ground  
2 Remote On/off  Open circuit 3 V. 

Current to ground 0.5 mA. 
3 Wheel encoder pulse input or 

output. 
TTL level pulses. Must have a 
short rise-time. 
Directly connected to pin 3 of 
the Auxiliary connector. 

4 Auxiliary pulses input. TTL level pulses. Must have a 
short rise-time. 
Directly connected to pin 4 of 
the Auxiliary connector 

5 Battery +ve output  
(to power encoder) 

+5.5 V minimum. 
300 mA maximum available. 

6 Not used  
7 Not used  
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SPECIFICATIONS OF THE 8381 GRIFFIN UMTS DOWN CONVERTER 
RF data  

Input frequency range  2000 to 2200 MHz 

Output frequency range  800 to 1000 MHz 

Noise figure < 8 dB; typical 5.5 dB 

Overall gain 0 to 3 dB; typical 2.0 dB 

Gain variation 
over freq. at 25 °C 
over freq. from 0 to 40 °C 
over level range < −30 dBm 

 
< 1 dB; typical 0.6 dB 
< 2 dB; typical 0.6 dB 
< 0.2 dB 

Nominal input impedance 50 Ω 

Nominal output impedance 50 Ω 

RFin/RFout VSWR < 2 : 1 

RFin/RFout return loss 

 

> 10 dB 

Image rejection > 70 dB; typical 90 dB 

Spurious response rejection > 40 dB 

Phase noise at 200 kHz offset < −100 dB/Hz 

LO level at RF input < −80 dBm 

Blocking level > 80 dB 

Maximum RF input level 
linear range (1 dB comp.) 
without damage 

 
> −15 dBm 
> +10 dBm 

External LO reference input 10 MHz, e.g. Griffin Receiver 

Frequency error based on reference 

General data  

Supply voltage 5.5 to 9.0 V 

Supply current < 300 mA; typical 165 mA 

Operating temperature range  0 to 50°C 

Dimensions 
UMTS Down Converter only 
with Griffin Receiver 

 
235 x 170 x 35 mm 
235 x 170 x 126 mm 
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SPECIFICATIONS OF THE 8382 GRIFFIN UP-CONVERTER 
RF data  

Input frequency range  300 to 500 MHz 

Output frequency range  800 to 1000 MHz 

Noise figure < 6 dB; typical 4.5 dB 

Overall gain 1 to 4 dB; typical 2.5 dB 

Gain variation 
over freq. at 25°C 
over freq. from 0 to 40°C 
over level range < −30 dBm 

 
< 1 dB; typical 0.8 dB 
< 2 dB; typical 1 dB 
< 0.2 dB 

Nominal input impedance 50 Ω 

Nominal output impedance 50 Ω 

RFin/RFout VSWR < 2:1 

RFin/RFout return loss 

 

> 10 dB; typ. 15 dB 

Image rejection > 60 dB 

Spurious response rejection > 40 dB 

Phase noise at 200 kHz offset < −100 dB/Hz 

LO level at RF input < −80 dBm 

Blocking level > 80 dB 

Maximum RF input level 
linear range (1 dB comp.) 
without damage 

 
> −15 dBm 
> +10 dBm 

External LO reference input 10 MHz, e.g. Griffin Receiver 

Frequency error based on reference 

General data  

Supply voltage 5.5 to 9.0 V 

Supply current < 300 mA; typical 164mA 

Operating temperature range  0 to 50°C 

Dimensions 
UMTS Down Converter only 
with Griffin Receiver 

 
235 x 170 x 35 mm 
235 x 170 x 126 mm 
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APPENDIX 1 − INSTALLING THE GRIFFIN SOFTWARE 

BEFORE YOU START 
The Griffin Front Panel Software will run on most PCs 
using a 486 or Pentium processor running Windows 95 or 
later versions of Windows. The only real essentials are a 
serial port (COM1, 2, 3 or 4) and sufficient space on the 
hard disk (10 megabytes). For best performance use a PC 
with a clock speed of at least 400 MHz and fitted with at 
least 64 Mbytes of RAM. 

Your software license allows you to install the Front Panel 
Software on as many PCs as you wish. 

Updating Existing Files 
During the installation process some files will be copied to 
your Windows folder. These are files that can be shared by 
many applications and there might be versions of the files 
already in your Windows folder. If the version on the 
installation disk is newer than the existing version then the 
existing file is replaced by the newer one. This is perfectly 
normal and is the Microsoft recommended procedure. 

INSTALLING IN WINDOWS 95, 98 
Insert the CD or floppy disk1. 
• Close all applications to avoid any conflicts with files in 

use during the installation process. 
• On the Start Menu choose Run then click on Browse. 

Browse on the CD or floppy disk drive until you find 
setup.exe. Click to select the file then click on Open to 
finish browsing. 

• Click on OK to start the installation process. 

The remainder of the installation process is automatic. 
If installing from floppy disks, insert subsequent disks as 
requested. 

INSTALLING IN WINDOWS NT4 OR 2000 
Follow the instructions for Windows 95, 98. 
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APPENDIX 2 − LOG FILE FORMATS 

INTRODUCTION 
The format of the data in the log file has been designed to 
be easy to import into standard Windows packages such 
as Excel, which means that it is not always the easiest 
format for you to read. 

The measurement parameters are stored at the end of the 
file, after all of the data. This is done to avoid confusing the 
automatic import algorithms in applications such as Excel. 

The log files are all in ASCII format even if the data link 
between the Griffin and the PC is set to Binary. 

The results are stored in the same units you have chosen 
for display of the results or counts as appropriate. 

Each 'column' of data is given a header in the first line of 
the results file. 

There are four fundamental formats to consider depending 
on the combination of modes chosen. They all follow the 
same strategy and are described in detail in the following 
sections. 

The numeric values in the file are separated by a character 
called a delimiter. You can change the delimiter to suit the 
program that you are going to use to process the data. 
Refer to Log File Delimiter in Setting Options. 

MEASUREMENT INFORMATION 
A block of Measurement Information is recorded at the end 
of the log file. This is in the format of the title followed by 
an = sign, followed by the actual value which might contain 
units. For example, the following is typical Measurement 
Information 

Recording start time = 07/08/2000 11:10:09 
Recording end time = 07/08/2000 11:10:12 
Frequency mode = Fixed 
Measurement mode = AFD 
Noise Filter Enabled, Bandwidth = 12500 Hz 
Number of samples = 1000 
Measurement period on each freq = 10 ms 
Sampling rate = 100.00 kHz 
Pause time on each freq = 1 ms 
Input attenuator = Auto 
IF bandwidth = 200 kHz 
 

Refer to Measurement Statistics section of Automatic 
Mode for explanations of these values.  
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FIXED FREQUENCY 

Simple Measurements 
There will be one line per measurement. The first number 
is the time from the PC clock when the measurement was 
made. The second is the time from the start of the 
measurements by the receiver in seconds. The third 
number is the measured value in the units that you 
selected. 

Histogram Measurements 
There will be one line per measurement. The first number 
is the time from the PC clock when the measurement was 
made. The second is the time from the start of the 
measurements by the receiver in seconds. The third 
number is the frequency in MHz or the channel number. 

The following 130 numbers are the Histogram counts, 
starting with the count for the lowest dB value and working 
to the greatest dB value. 

CYCLING OR SCANNING IN FREQUENCY 

Simple Measurements 
There will be one line per Cycle or Scan. The first number 
is the time from the PC clock when the measurement was 
made. The second number is the time from the start of the 
measurements by the receiver in seconds. The following 
numbers are the measured values for each frequency or 
channel in the units that you selected. 

Histogram Measurements 
There will be one line per measurement. The first number 
is the time from the PC clock when the measurement was 
made. The second is the time from the start of the 
measurements by the receiver in seconds. The third 
number is the frequency in MHz or the channel number. 

The following 130 numbers are the Histogram counts, 
starting with the count for the lowest dB value and working 
to the greatest dB value. 

As the receiver Cycles or Scans round the frequencies you 
programmed so there will be one line in the file for each 
frequency.  
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APPENDIX 3 − TROUBLESHOOTING GUIDE 

COMMUNICATIONS PROBLEMS 
If the Status bar never changes to show Griffin Connected 
there must be a problem with the communications link 
between the Griffin hardware and the PC running the Griffin 
Front Panel Software. 

The software automatically tries to connect with all of the 
baud rates that are supported by the Griffin. If it cannot 
connect then there might be a problem with the physical 
connection. 

Basic Checks 
First try checking: 
• That the Griffin is connected to the correct COM port. 
• The cable connecting the Griffin to the PC is secure at 

both ends. 

Try replacing the cable in case it is faulty or testing it as 
described below. 

Testing the Griffin and Cable 
One way to check the output from the Griffin and the cable 
is to connect an oscilloscope to pin 2 (ground to pin 5) of 
the null modem cable. When you turn the Griffin on it 
should output a short message which will be seen on the 
oscilloscope. This will check the ground and one data line 
in the cable. To check the other data line reverse the cable 
and repeat the test. 

Testing the PC Port 
You can use HyperTerminal, which is a communications 
programme supplied with Windows to check the serial port 
in the PC. HyperTerminal does not support all of the Baud 
Rates that the Griffin can use so you might not be able to 
communicate with the Griffin, but it worth a try. 
• Close the Griffin Front Panel Software. 
• Open the HyperTerminal Folder (Start, Programs, 

Accessories, Communications, HyperTerminal) then 
click on hyperterm.exe to start HyperTerminal. 

• Enter a name for the connection. 
• Choose Direct to COMx, where x is the number of the 

COM port that is connected to the Griffin, in the 
Connect using section. HyperTerminal will complain if 
the port is not available. Check that you have closed 
the Griffin Front Panel Software. If it is closed then 
either there is no COMx on your PC, or some other 
programme is using it.  
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• Set the port settings to: 
Bits per second − the Baud rate that the Griffin is 
set to. 
Data bits − 8. 
Parity − None. 
Stop bits − 1. 
Flow control − None. 

• Then press OK. 
• Try turning the Griffin on and off. If the connection is 

working you will see the power-up message appear. 
This should be the pu000000000000. If anything else 
appears it is likely that the Baud rate is wrong. Try 
changing the Baud rate until the message is correct.  
To change the Baud rate in HyperTerminal  

Choose Properties from the File menu, then click 
on Configure.  
Make the changes then click on OK. 
Now save the settings (choose Save from the File 
menu) then close HyperTerminal. You can choose 
where to save the file but a convenient place is 
your desktop. 
Double-click on the file (or its icon) to re-open 
HyperTerminal. 

• Once you can see the power-up message you can try 
sending a message to the Griffin to test the other 
direction of data flow. Type PWU followed by pressing 
enter (also called carriage return). If everything is 
working properly the Griffin will respond with 'kAPWU'. 
Note that you might not see the characters that you 
type as there is a setting in HyperTerminal that can hide 
or show them. 

If this does not resolve the problem then contact Willtek. 
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